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Chapter 1. Release Notes

Contains information about new features, defect fixes, and known issues in Unica

Campaign and Optimize that HCL releases as part of a scheduled software release.

Unica Campaign 12.1 system requirements and
compatibility
Unica Campaign is part of the Unica suite of products. Unica Campaign version 12.1

requires Unica Platform 12.1.

Where to find complete system requirement and compatibility information

For a list of Unica product versions compatible with this product and a list of third-party

requirements for this product, see the Recommended Software Environments and Minimum

System Requirements document. ).

You can also access this document by selecting Help > Product documentation when you

are logged in to Unica.

Prerequisites for using Unica Campaign
Before you begin using Unica Campaign, confirm that your environment meets the following

requirements.

• For an improved user experience, use at least a 21" screen.

• For an improved user experience, set your screen resolution to 1600 x 900. Lower

resolutions can result in some information not being properly displayed. If you use a

lower resolution, maximize the browser window to see more content.

• A mouse is best for navigating in the user interface.

• Do not use the browser controls to navigate. For example, avoid using the Back and

Forward buttons. Instead, use the controls that are in the user interface.
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• If pop-up blocker (ad blocker) software is installed on the client machine,  Unica

Campaign might not function properly. For best results, disable pop-up blocker

software while running Unica Campaign.

• Ensure that the technical environment meets the minimum system requirements and

the supported platforms.*

• The correct browser and versions must be used.*

• Clear the browser cache after upgrading or applying any fix pack. This only needs to be

done once, after the application is updated.

• If you use Internet Explorer (IE) with Unica Campaign or any module that uses Unica

Campaign flowcharts (Unica Deliver, Unica Optimize, Unica Interact, Unica Collaborate):

To log in multiple times to view side-by-side information, open IE and log in to Unica.

Then select File > New Session in the IE menu bar. In the new IE browser window, log in

to Unica as the same or a different user.

Important:  Do not use any other method to open multiple sessions. For example,

do not open a new tab; do not open another browser session from the Start menu or

desktop icon; and do not use File > New Window in IE. These methods can corrupt

information that is shown in the application.

*For details on the items indicated by an asterisk, see the Unica Recommended Software

Environments and Minimum System Requirements.

Unica Campaign documentation roadmap
Unica Campaign provides documentation and help for users, administrators, and

developers.

Table 1. Get up and running

Task Documentation

Find out about new features, known

issues, and limitations

Unica Campaign Release Notes
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Task Documentation

Learn about the structure of the

Unica Campaign system tables

Unica Campaign System Tables and Data

Dictionary

Install or upgrade Unica Campaign One of the following guides:

• Unica Campaign Installation Guide

• Unica Campaign Upgrade Guide

Unica Insights Reports for Unica

Campaign

Unica Insights Installation and Configuration Guide

Implement the IBM Cognos® reports

provided with Unica Campaign

Unica Reports Installation and Configuration Guide

Table 2. Configure and use Unica Campaign

Task Documentation

• Adjust configuration and security

settings

• Prepare Unica Campaign for

users

• Run utilities and perform

maintenance

• Learn about integrations

Unica Campaign Administrator's Guide

• Create and deploy marketing

campaigns

• Analyze campaign results

Unica Campaign User's Guide

Improve flowchart performance Unica Campaign Tuning Guide

Use Unica Campaign functions Macros for HCL Unica
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Table 3. Integrate Unica Campaign with other HCL products

Task Documentation

Integrate with IBM Engage Campaign and Engage Integration Guide for IBM

Marketing Cloud

Integrate with IBM Digital Analytics Unica Campaign Administrator's Guide: How to

configure the integration

Unica Campaign User's Guide: Targeting IBM

Digital Analytics segments in campaigns

Integrate with Unica Plan Unica Plan and Unica Campaign Integration Guide

Integrate with  Opportunity Detect Unica Campaign Administrator's Guide: How to

configure the integration

Opportunity Detect Administrator's Guide

and Opportunity Detect User's Guide: How to

administer and use the product

Integrate with Unica Deliver Unica Campaign Installation and Upgrade guides:

How to install and prepare Deliver components in

the local environment.

Unica Deliver Startup and Administrator's Guide:

How to connect to the hosted messaging

resources.

Unica Campaign Administrator's Guide: How to

configure offer integration.

Integrate with IBM SPSS Modeler

Advantage Enterprise Marketing

Management Edition

Unica Campaign and IBM SPSS Modeler

Advantage Enterprise Marketing Management

Edition Integration Guide

Integrate with IBM WeatherFX. You can integrate WeatherFX with Campaign

so that you can pull weather events into your

marketing campaigns. Unica Campaign version 9
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Task Documentation

and version 10 users can integrate with WeatherFX

by using the UBX toolkit.

Integrate with  Unica Director. Unica Director Installation Guide: You can

integrate  Unica Director with  Campaign so that

you can get status of all the running/completed/

failed flowcharts, migrate Camapigns from one

Unica Campaign environment to other, download/

delete flowchart logs etc.

Integrate with Journey Unica Campaign can integrate with Journey so

that a continuous communication with users

can be established based on the inputs from

Campaign.

Refer Campaign Administrators guide > Unica

Campaign and Unica Journeys integration

Integrate with Link Unica Campaign uses Link capabilities of

connectors which include the configuration and

provisioning to connect to any delivery channel.

Refer Campaign Administrators guide > Unica

Campaign and Unica Link integration

Note:  Additional integrations may be available that are not listed in this table. See

Product tools and utilities for Unica Campaign.

Table 4. Develop for Unica Campaign

Task Documentation

Use the REST API See the Unica Campaign REST API

Use the SOAP API • See the Unica Campaign SOAP API

Specification

https://www-947.ibm.com/support/entry/myportal/clientsidetools/enterprise_marketing_management/ibm_campaign?productContext=-198760082
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Task Documentation

• JavaDocs in devkits

\CampaignServicesAPI

Develop Java™ plug-ins or command-

line executables to add validation to

Unica Campaign

• See the Unica Campaign Validation PDK Guide

• Java-docs in devkits\validation

Table 5. Get help

Task Instructions

Open online help When using the Unica Campaign application:

1. Choose Help > Help for this page to open a

context-sensitive help topic.

2. Click the Show navigation icon in the help

window to display the full help.

You must have web access to view context-

sensitive online help. Contact  Support for

more information about accessing and

installing  Knowledge Center locally for offline

documentation.

Get PDFs When using the Unica Campaign application:

• Choose Help > Product documentation to

access Unica Campaign PDFs.

• Choose Help > All Unica documentation to

access all product PDFs.

• Click the links for PDFs during the installation

process.
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New features and changes in version 12.1
Unica Campaign 12.1 includes a number of new features and changes. These are listed

underneath.

For a list of newly supported and discontinued platforms, see the Recommended Software

Environments and Minimum System Requirements guide.

Upgrade Paths

• Supported upgrade path via installers: 11.1.x -> 12.1 and 12.0.x -> 12.1.

• Customers prior to 11.1.x must perform Fast upgrade to 12.1.

Fast Upgrade

Unica Campaign 12.1 supports the fast upgrade approach. This approach allows upgrades

from version 8.6 onwards to version 12.1. This helps customers bypassing the multi-step

upgrade. The Fast Upgrade approach is also useful in reducing upgrade downtime. The

approach is provided for  Unica Platform,  Campaign,  Optimize,  Plan,  Interact for upgrade

from 8.6.x version onwards. For details, see the Fast Upgrade documentation released with

version 12.1.

Campaign Integration with Journey

In V12.1 Unica introduced a new product – Journey - which helps marketer to establish a

continuous communication with users based on user’s responses. Journey is more focused

towards establishing a continuous dialog with user across multiple channels like Email,

SMS and CRM.

Campaign has rich segmentation capabilities. For an enterprise organizations Campaign

helps to perform segmentation of a huge customer base and identify segments of customer

who can be targeted for marketing. Campaign segments / audience information could

be pushed to Journey and Journey can help in continuous dialog with user. In Campaign

flowchart a new process box is provided publish the audience information to Journey. This

audience information will be sent via kafka instance being used by Journey application.
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Please refer to Campaign Administration guide for more details.

Campaign Integration with Deliver

In V12.1 of Unica suite we have introduced Unica Deliver – EMAIL and SMS delivery solution

which is tightly integrated with Unica Campaign. This has empowered Unica Campaign to

run Campaign email and SMS execution seamlessly with Unica Deliver. For email deliveries

Unica Deliver captures the offers contacts and responses and made them available in

Campaign for drip marketing.

Unica Deliver and Campaign integration now enables marketer to:

• Conduct a targeted, measurable Email Marketing Campaign .

• Define and create lists of email recipients using Deliver process box in Campaign.

• Interface that allows you to edit and personalize the email you want to send emails.

• Configure, execute, and monitor Deliver mailings using a mailing tab provided in the

Campaign interface.

• Send personalized email messages to a list of selected individuals.

• Tracking responses.

• Create mailboxes to accommodate responses by email.

A new process box with name “Deliver” will be available in Campaign flowchart which can

be used to send communications via deliver.

Please refer to Unica Deliver documentation for more details.

Campaign with Link Integration

In V12.1 Unica introduced a new product component in Unica suite called as “Unica Link”.

Unica Link has extended capability of Campaign to be flexible enough to connect with any

delivery channel via REST capabilities.

Along with V12.1 - Unica Link will be providing reference connectors for below delivery

channels:
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• Salesforce(CRM)

• MailChimp and Mandrill(email)

• Twilio(SMS)

Unica Link provides a connector framework to build any type of connector based on

REST.#These capabilities can be leveraged with HCL services help in V12.1.

In Campaign application a new process box – Link is introduced. This process box will allow

user to create connections to the underlying connections.

Link process box in Campaign generates an output data in flat file and shares that data

with Unica Link application on a shared drive. Unica link will also capture the responses and

generate the results in flat file on the same shared drive.

Unica Insights - Reporting Tool Support for MariaDB

Unica V12.1 reporting tool is rebranded with name as Unica Insight. It still operates based

on BIRT reporting tool. In V12.1 reporting is extended to support MariaDB system tables.

• Unica Insights – reporting based on BIRT reporting tool.

• Campaign – out of the box reports available for MariaDB system tables using Unica

Insights.

• Unica Insights tool would be default bundled and available with Unica Marketing

Platform.

• Campaign provides all out the box support with Unica Insights system databases such

as SQL, ORA, DB2 & MariaDB.

Please refer to Unica Insights Reporting documentation for more details.

Campaign Licensing

Starting from V12.1 Unica product suites are license enabled. Unica products will need

appropriate licenses to for production use. Other than production environments do not
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require to have the licenses. Each product in Unica suite license type is different. Please

refer to HCL Unica Suite Licensing guide.

License definition for Unica Campaign:

• Based on numbers of marketing records processed in Campaign/Optimize.

• Track the count of the audience (lead/contact) to whom you will send the

communication or any other marketing message.

• In simple words, the number of audiences who are being processed by Unica

Campaign.

• Shows the consumption count of these audiences processed from Unica Campaign.

• Provides term and perpetual licenses for Campaign.

Optimize Licensing

Optimize license is based on license key – you can contact to Unica Sales / Support team to

get the license for optimize. Optimize licenses are required to be applied on production and

non-production environments. Please follow below steps to get the Optimize license:

1. You will need to provide the hostname of the machine where you are running Campaign

listener to execute optimize sessions.

2. Once you provide this hostname support team would be providing you the license file.

3. Copy the license file in Campaign/conf directory.

Addition in Campaign REST APIs

A new API is made available to get the list of table catalog in the mentioned API. This

will help marketer to details of mapped tables in the loaded table catalog and use this

information while designing the process box expression.

Under Campaign flowchart APIs are provided for Snapshot process box configuration. User

can configure the snapshot process box with below configurations:

1. Output to flat file (this does not include output to file with existing data dictionary).

2. Output to database table (base/dimension/general).
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3. Output to database table with append or replace operations.

4. Map the output fields in the snapshot process box.

5. Using derived fields in output via APIs is not yet supported.

Campaign Listener Clustering Supports UNC Path for Cluster Share on
Windows

Campaign listener clustering on windows now support the cluster share path in below

format.

You can use this path under configuration parameter: Settings for

'campaignClustering' (Affinium|Campaign|campaignClustering)

CampaignSharedHome = \\zebra39.hclpnp.com\CampaignClusterShare\partition1

Add token <KEYCOLUMNS> only for Audience ID and < TABLECOLUMNS > for
table field

In earlier Campaign versions under datasource configruation – for

'TempTablePostExecutionSQL' while creating unique Index only Audience ID was

considered. In V12.1 we have introduced a new token <TABLECOLUMNS> along with

<KEYCOLUMNS> token. So, if you provide <KEYCOLUMNS> token in Unique Index creation

query then only Audience ID will be considered and if you provide <TABLECOLUMNS> all

other fields other than Audience ID will be considered. In case user wants all the fields to

be considered then new query would be for 'TempTablePostExecutionSQL' CREATE unique

INDEX <TABLENAME>_IX1 ON <TABLENAME> (<KEYCOLUMNS> <TABLECOLUMNS>)

Fixed defects in Unica Campaign V12.1
The following defects were fixed in Unica Campaign 12.1.

Issue key Summary

HMA-309022 Campaign flowchart API throw Internal Server error.
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HMA-312315 Effective date/expiration dates after 2020 result in bad date.

HMA-304847 Angularjs version upgrade to 1.7.9 .

HMA-311592 Fixes for Reflected Cross-Site Scripting

HMA-310375 Campaign Owner field is displaying the user ID instead of the Name in

V11.1

HMA-310382 Optimize Scoring table displayed upside down.

HMA-310380 Security Vulnerability: Cross Site Scripting INC8959653.

HMA-310372 errorPageCSRF.jsp single quote problem for french message.

HMA-310622 Difference in index creation from 10.0 to 11.1.

HMA-310623 Execution of segment process box with error CODE 10613: Field not found.

HMA-307221 Fixes in Swagger Tool on Campaign.

HMA-311366 Pagination not working in Campaign advance search window.

HMA-307953 Campaign API call: Error while Creating Extract process box with criteria to

select customers.

HMA-287701 Unable to add segments in Exclude/Include rules of Contact Optimize

session.

HMA-279621 Spelling error on UI for contact optimization summary page.

HMA-279675 In Optimize - Analysis tab, for Offer Filtering Summary report, the blue BAR

is overlapping on the Offer Count Section.

HMA-310492 Analysis tab of strategic segments.

HMA-307219 Create folder with children folder API call is not working as expected .

Known issues in Unica Campaign V12.1
Unica Campaign 12.1 includes the following known issues.
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Table 6.

ID Known issues

310343 Campaign flowcharts with old eMessage process box will not work in

v12.1.

312109 Campaign upgrade installation from 12.0 to 12.1 completed with 3 non-

fatal error.

300159 HTTP Communication error occurs, while saving flowchart if Unica

Platform and Campaign applications are using the same JNDI.

It is suggested to use separate JNDIs for Platform and Campaign

applications.

295574 Deployment of Campaign application in wWebSphere application

server failed due to java.lang.NoClassDefFoundError:

javax.el.ELManager. Users are required to copy

javax.el-3.0.1b11.jar in the Websphere application servers lib

directory. They can download javax.el-3.0.1-b11.jar from https://

mvnrepository.com/artifact/org.glassfish/javax.el/3.0.1-b11.

311916 Journey Process box: Searching in Journey PB retains its last search

string. User need to manually clear the search criteria.

306110, 306108 While deploying or starting Campaign application, it throws errors

related to module-info.class, and warning related to obsolete hibernate

namespace. These can be ignored.

304803 Getting "jcc][t4][10217][10310][4.14.111] Connection read-only mode is

not enforceable after the connection has been established." warnings in

WebSphere console log. No impact on application side. These can be

ignored.

306095 Production documentation links on Campaign installer are broken. See

the documentation available along with product installers.

https://mvnrepository.com/artifact/org.glassfish/javax.el/3.0.1-b11
https://mvnrepository.com/artifact/org.glassfish/javax.el/3.0.1-b11
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ID Known issues

312150 Journey Process box: Search in Associated Journyes with multiple

words is not working.

310126 eMessage instances in Campaign uninstall folder – these can be

ignored. Unica no longer support eMessage.

312299 Campaign or Platform navigation url when contains default http or https

port then recent menu’s does not work. If you are using default http (80)

or https (443) ports in navigation url please remove them.

312231 Campaign swagger APIs will not work only on swagger page when

marketing platform login method is set to Web Access control.

303532 With MariaDB as system database Optimize, Maillist or Calllist process

box execution fail with error 10646. You must enable In DB Optimization

in flowchart advance settings to resolve this error.

13460 When the Export to File option is unchecked on the Fulfillment tab of

the Mail List process, the Summary File option is enabled but should

not be.

175825 When defaultBehaviorWhenOutputToFile is set to Create New File, it

works only when you select a new output (export) file for the first time.

If you try to change the existing output file and select a new output file,

then the option Append to Existing Data gets selected by default.

It can be changed manually to Create New File.

APAR 198495,

PO05293,

198494

For a custom macro, if a user account has assigned as Not Granted

permission for a stored object (Custom Macros, Flowchart Templates,

Stored Derived Fields, etc.), the custom macro can be used to edit,

delete, add, move all stored objects regardless of permissions.

204347 LARGE_DATA: Browser Crash - Mail List process box with 700 segments

- Save with 512 offers to each segment.



Unica Campaign V12.1 Release Notes | 1 - Release Notes | 15

ID Known issues

211253 File-based input with multiple columns containing date in different

format does not read the date correctly.

212890 Boolean type column on Amazon Redshift is recognized as 'Test' field

type in table mapping.

220474 When the column name of the source table contains Non-ASCII

characters and is long (probably longer than 10 x 3bytes characters in

UTF8), the Snapshot process does not run because the temp table is

not created.

220705 Profiling count for Dimension table fields is incorrect and profiling

percentage is displayed as 100% even if profiling is in progress.

APAR 222047,

PO06172,

222049

Unica Campaign extract process does not write to DB2 database when

flowchart is configured with two extract processes and the second

extract process contains a derived field that uses French accented

characters in the name of the derived field.

APAR 225568,

PO06304,

225572

temptablepostexecutionsql is not run when selecting coremetrics

segment.

230340 Inconsistent behavior for the Mail list process is observed when the

data filter is assigned to Effective date on the Parameters tab in a new

Mail list process when compared to an edited existing Mail list process.

The Mail list process does not output a datetime derived field in the

output log file. Changing the effective date parameter values might

cause execution failure of the Mail list.

230606 In a flowchart where fields are extracted and used in a Mail list process,

the fields under Extract Node on the Personalization tab of the Mail list

process are different before and after running the process.
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ID Known issues

231859 While using the Chrome browser, it takes around 20 seconds to respond

while loading the Personalization tab of the Mail list process if it

contains large number of treatments and offers assigned. For example,

a Mail list process with 250 cells, each cells with multiple offers, each

offer having multiple attributes.

232502 A Mail list performance issue occurs when the user changes the input

in any way and there is a delay when initially switching tabs. After the

user changes the input and switches to the Treatment or Process tab

for the first time, there is a delay of around 10-15 seconds depending on

the number of inputs selected. After this initial delay, there is no delay

until the input is changed.

232835 The Campaign application performance is affected and sometimes an

exception error message is displayed on the Campaign pages when

the application is used for a longer time (some days) with continuous

usage. You must restart your Campaign web application and Campaign

Listeners

238789 While using the Chrome browser, when a user opens a Mail list with 600

cells having multiple offers assigned to each cell, the application stops

responding. While using the Internet Explorer 11 browser, nothing is

displayed in the Mail list process box.

239142 When the Audience process fails because of an incorrect Count

filter expression, and the user removes the filter expression, adds a

Condition, and runs the Audience process again, the process fails.

The Condition is not considered and instead the previous Count filter

expression is used resulting in the failure. To run the Audience process

successfully, you must re-open the Audience process configuration

window, click the Condition, Save and Close. The Audience process now

considers the Condition and runs successfully.
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ID Known issues

APAR 243895,

PO06966,

243897

A space character is converted to '' while profiling.

PMR 223848,

245664

Irrelevant flowcharts turned up in a Campaign when different users

access different flowcharts at the same time, the wrong flowchart

seems to be displayed.

248007 Hive Performance: PRE -Single Insert statements executed for loading

data in temp tables (extract) when used with Hive takes 19 minutes for

2000 records.

PMR 269280,

269765

Truncate does not function for the DB2 database. The

DeleteAsTruncate property specifies whether, when an output process

is configured to REPLACE TABLE, Campaign uses TRUNCATE TABLE

or deletes from the table. When the value is TRUE, Campaign runs a

TRUNCATE TABLE from the table. When the value is FALSE, Campaign

runs a DELETE FROM from the table. The default value depends on the

database type, with a large number of clients moving from Oracle

to DB2 the difference in performance is extremely noticeable. The

comparison in performance in Snapshots and Mail lists for customers

leaving Oracle to DB2 is drastic.

269785 For the Chrome and Safari browsers, when the locale is set as

Japanese, the labels overlap the buttons in the Save template window.

270528 Use and Profile buttons remains enabled for the Select process when

the user selects some table fields and then applies the search filter in

the Select process such that it does not return any matching table.

270814 Users cannot select values from the On a trigger drop down by using

the mouse on the Scheduler page.
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ID Known issues

271642 A "Please wait....." message is displayed multiple times in console

mode installation while upgrading from version 10.1 and also for new

Installation

271676 The Extract table on the DB2 and Oracle databases is not deleted when

In-DB optimization is unchecked.

272253 The Campaign application performance is affected when a user opens

the Table mapping window and more than 500 tables are mapped.

2968 Hot keys are not implemented on most of the windows. In the Dojo

implementation it is not possible to use keyboard shortcuts to activate

certain functions. Instead the user must click buttons.

PMR 266519,

75262

Clicking Return to previous page distorts the user interface in some

cases. Use the links within the products to navigate, rather than the

browser controls.

N/A When Unica Campaign is deployed in an application server cluster

environment with 80 port, the Campaign navigation URL should not

contain this port number. For example: http://<host>.<domain>:80/

Campaign should be changed to http://<host>.<domain>/

Campaign. Change the value of the serverURL property under Campaign|

navigation on the Settings > Configuration page.

N/A Mail List process box gets unconfigured with error "31606: History

table are changed" on Flowchart run.

1. There is no issue if the history tables are mapped prior to building a

flowchart and adding a Mail List process.

2. If you do not follow step 1, you can still map the history tables

after the error appears. If you edit the flowchart and configure the

process box, the process will run.
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ID Known issues

N/A After migrating non-ASCII data to Campaign, in some cases you cannot

open Campaign flowcharts on the target system. Session flowcharts

open successfully. To work around this issue, remigrate the campaigns

in overwrite mode. You can then open the flowcharts.

TT 062333 Information related to associated products does not appear in offer

on Marketing Operations. When an offer created in Campaign with

products associated with it is imported in Marketing Operations,

information about the associated products is not available in Marketing

Operations.

270655 Table Mapping : Table name containing @ is supported while mapping

a table, special characters like @ are should not be supported in Table

names. Since Table name containing @ is supported since some time,

this functioning is not updated now.

283637 When user has one maillist PB configured in the flowchart and he

adds another maillist PB in the same flowchart, it is observed that All

the values from already configured in treatment tab, Parameters tab,

Personalisation tab of new Maillist PB appear automatically in any new

dragged maillist PB.

281389 While running Campaign in the Upgrade mode, the installer should read

the installation properties files from the previous version response

files as we had that response available at the install location from

the previous installation. However, it does not read the installation

properties files from the earlier version response files.

280623 In Sample PB if we specify '3' in "# of Samples/Output Cells" field and

Configure [sample1] with 3 samples having sample sizes as 50%, 50%

and "All remaining records" respectively based on "Random Sample

method" then after running Flowchart if we reopen the Sample PB
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ID Known issues

"Process run results will be lost. Continue?" message is displayed in

sample PB when remaining All check boxed is check.

283101 CHROME: "Unable to notify roles/permission changes to Campaign,

Deliver OD may be out of sync". On clicking save changes for the

Security Policy displays the following pop-up, this happens just first

time after user logs in and changes anything in the policy and clicks

save changes. Also, this is reproducible just on CHROME. Tested on

Chrome V64 and V65.

282844 Campaign Offer doesn’t sort on 'Channel' & 'Eff./Exp.Dates'. After

clicking on every column the offers below it should be sorted in

ascending order. If you click on the same column the second time, the

offers beneath it should be sorted in the descending order.

283695 Segment process box execution failed with extract enabled to User

database for the IMPALA user DB. This error does not reproduce when

extracting to Unica Campaign server.

284436 Platform.war and campaign.war in ear file deployment will not work in

Weblogic 12.2.1, work around is to deploy campaign.war and unica.war

separately

288228 If the date field uploaded to IMC side is not in mm/dd/yyyy format, the

email process box fails to execute. This data format is required by IMC

Importlist API. It works accurately if DELIM_M_D_YYYY(mm/dd/yyyy)

format is used for date while uploading to IMC using importlist API.

289135 TOMCAT : Occasionally Unica Platform or Campaign does not gets

started after deploying in tomcat application server. Workaround :

delete Campaign and Platform directory available inside Tomcat

webapps directory and delete the content of work directory from the

path where Tomcat is installed.
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ID Known issues

304945 Refresh command does not refresh the master listener priority or

weight, if you need to make changes in priority or weight you require to

take a downtime and restart the application.

312445 Link Process box - sending data only for the first input cell selected to

link.

UL-285 Connection Salesforce - Subsequent Salesforce actions are failing for

Update (Lead/Contact) intermittently.

UL-250 Connection Mandrill - Intermittenly stop sending emails to targeted

audiences.

UL-281 Connection Mandrill - Subject line with non english characters - mandrill

not sending email to user.

UL-259/UL-242 Connection Mailchimp/Mandril - results would be available for 1000

users only.

UL-214 MailChimp/Mandril - Audience value is getting changed to id field after

selection or reopening process box.

UL-194 MailChimp/Mandril - In Mandrill template if merging field added as

localized character - personalization is not working.

UL-257 Link Connections page takes time to load in the Campaign process box.

UL-231 Twilio Connection - Only 5 fields are supported for personalization in

SMS body/text area.

UL-279 Connection MailChimp - Branch run or single link process box run is not

supported with Link process box with Mailchimp connection. You will

need to execute complete flowchart.

UL-287 Link process box fails when no output data.
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NA Unica Campaign and Unica Link applications urls should be having

same domain names. Unica Campaign and Link applications deployed

on different domains will not work.

UL-189 Connection Mandrill/MailChimp- Emojis are not working in Mandrill and

MailChimp connector Mail Subject line.

313650 Platform Scheduled flowcharts are not getting executed

afterupgrade.Use the quartzjobtool to update scheduler jobs. This is

a requiredstep. If this upgrade tool is not run, any existing scheduled

job willfail to start. The quartzjobtool is in the tools\bin directory

underUnica Platform installation. Run this utility from the tools

\bindirectory.Example command (Windows): quartzjobtool.batExample

command (Unix): ./quartzjobtool.sh

306383 UBX registration utility is failing with error Caused by:

java.lang.ClassNotFoundException: org.jboss.logging.BasicLogger error

316802 12.1 FP2 MariaDB]:CODE 704: File write error. while extracting extracted

fields and table fields to database server through Segment PB

Known issues in Optimize V12.1

Issue Issue ID Description

Scores entered manually in the score

matrix are not considered while

optimizing the contact list.

Defect 194109 Scores entered manually

should be considered for

calculation in the Customer

Capacity rule. However,

while applying the Customer

Capacity rule, scores in the

PCT are considered, and

all customer records are
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removed in the optimized

list.

Campaign Optimize summary report is

incorrect.

Defect 176368 If offer versions are used

in a rule, the report that

shows pre-optimization

versus post-optimization

counts will always report

the pre-optimization count

of records as 1. The post-

optimization counts will be

correct.

After upgrading Campaign to 9.1,

Optimize listener can no longer be

stopped via ACOServer.sh.

Defect 81245 Users must upgrade Unica

Campaign and Unica

Optimize together. If they

cannot, they will need to

stop the Unica Optimize

listener manually through

the task manager/kill

command.

Error messages for the ACOOptAdmin

utility do not display according to non-

English locales.

DEF051284 When you run the

ACOOptAdmin command

line utility in a locale other

than English, error messages

do not display according

to the specified locale. The

error messages display only

in English.
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unprocessables_sessionid.csv

might contain some customers who

receive offers.

DEF054841 In some scenarios, a

few of the customers

who get offers might

be present in the

unprocessables_sessionid.csv

file.

Incorrect optimization result with

Custom Capacity rule in specific

circumstances.

DEF058362 A customer that satisfies

the following criteria might

receive fewer offers than

wanted:

• The customer has

an even number of

proposed transactions.

• Each of these

transactions has the

same score.

• This score is a low

value.

Some labels display incorrectly in

Japanese, Chinese, and Korean.

DEF059595 Some translated labels are

displaying incorrectly. For

example, when you edit the

score matrix manually, the

vertical label on the right

side of the table displays

upside down. Also, for

optimization rules that

contain customers in the

segment, the segment label

displays on two lines.
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Offer filtering summary report displays

an incorrect count of Proposed

Contacts that are removed by each

Custom Capacity rule.

DEF059805 The Offer Summary Report

displays incorrect counts in

the "Removed By This Rule"

column for Custom Capacity

rules if the participating

Flowchart for this Unica

Optimize session contains

multiple contact dates and

multiple offers that are

made to each customer on

different channels.

Issues with offer version query builder. DEF060676 There are several minor

issues with the offer version

query builder:

• For custom attributes

with the Form Element

Type of Select Box,

the offer version query

builder does not use

the select box. You

must enter the value

manually.

• When the group level is

removed, the subgroup

conditions are added

to the parent condition,

and vice versa.

• All arithmetic operators

are displayed for a

string variable, but only
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equal and not equal

apply.

• Defined length

validations for attributes

are not verified upon

input for conditions.

Offer version rules that contain dates

do not provide expected optimization

results.

DEF061554 If you create an offer version

condition that includes

a date, such as the offer

parameter "valid end date"

equals "12/31/2011", the

rule containing offer version

condition might not be

satisfied; however, the rest

of the rules will work as

expected.

Rule exceptions that span calendar

years give incorrect results.

DEF061639 If you create a rule exception

to a Min/Max # Offers

capacity rule that spans

calendar years, such as

07/01/2011 to 06/30/2012,

the rule containing rule

exception condition will not

be satisfied; however, the

rest of the rules will work as

expected.

<unica_svradm> refresh command

does not reflect the change.

HMA-304945 On a running environment,

after changing the

master listener priority,

<unica_svradm> refresh
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Issue Issue ID Description

command does not reflect

the change.

<unica_svradm> refresh command

does not delete the node from cluster.

HMA-305764 If you delete a listener

node from existing cluster,

<unica_svradm> refresh

command does not delete

the node from cluster.

Execution requests are

still observed going to the

deleted node. Restarting the

listener solves this issue.

Will be fixed in upcoming

fixpack.

Users are still able to manually

interfere in the running flowchart when

flowchart execution is in progress

through SVRADMIN utility.

HMA-306037 When flowchart execution

is in progress through

SVRADMIN utility or using

scheduler, user is still able

to manually interfere in the

running flowchart. Will be

fixed in upcoming fixpack.

Known limitations in Unica Campaign V12.1
Unica Campaign 12.1 includes the following known limitations.
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Table 7. Unica Campaign known limitations

ID Known limitation

304128 Platform login method or users authentication from third party directory

services is not supported with Campaign or Optimize APIs. Users

require to use the Unica Platform user to use with APIs.

305130 The flowchart template is not imported, if it contains data source name

more than 256 character length. Save the flowchart template again by

changing the datasource name with less than 256 chars.

305764 For any reason, if users delete the Campaign listener node configuration

from listener cluster configuration in Unica Platform, while the

application is up and running then users connected to this listener node

are not redirected to another listener. You must restart the Campaign

web application. If you require to delete the listener node, take a

downtime and restart Campaign web and listener components.

17202 Error 19024: Cannot delete segment folder if the segment was deleted

from the folder. A segment that is deleted from a folder remains as an

inactive segment in the folder. Folders with inactive segments cannot

be deleted. This is working as intended.

185854 Big data: Campaign integration with Hadoop-based Hive big data as a

user data source is not tested on MS Windows operating system.

190621 Big data: Campaign with Hive big data as a user database does not

support user table mapping with Base and Dimension levels up to the

fourth level hierarchy. If you map a Base record table with four levels of

dimension tables in a Select process box, then build a query based on

the fourth level Dimension table, the query fails with Error 11528. This

issue should not affect big data users because multiple dimensions

should not be needed. By definition, a big data source has a large table

of records split across Hadoop nodes (such as HDFS).
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194095 For Redshift database, the error message "Unsupported type

timestamps with time zone" is displayed when exporting data from a

Snapshot process box. Timestamp with timezone is an unsupported

PostgreSQL data type on Amazon AWS.

195581 While running a Campaign flowchart, if listener crashes or is stopped,

user is not able to access the running flowchart from the UI. Requests

are being served by another node of the cluster but while accessing the

flowchart, a pop-up message says "listener failover occurred..." It may

be necessary to restart the master listener.

232032 User can start only one Campaign listener on one server (machine) in

case of Listener clustering.

PMR 243195,

244148

When a column that has the Greek Letters A and B is profiled in

Campaign, the system returns only A along with the count of all the

records. After the fix, some of the non-English characters, which differ

only in case (like é and É in French), are counted as two different values

in profiling. English language characters are not counted as case

sensitive.

244482 Deep search lists all the Campaigns that are created through Marketing

Operations projects when Campaign - Marketing Operations integration

is on. Campaigns that are created through Marketing Operations

projects when Marketing Operations - Campaign integration is enabled)

are not listed on Campaign list page and are only available on the

Marketing Operations project listing page. Users who do not have

the permission to access Marketing Operations are able to access

campaigns which are created through Marketing Operations projects

through Deep search results.

248943 If the user profile database is changed (change in the table column

values of audience record) for fields other than sync fields and the
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user runs the Email process again, a negative count is returned for the

DUPLICATES parameter from Engage in the Campaign flowchart log.

N/A Big data: To perform the UPDATE operation on any process boxes in a

flowchart, ensure that your HIVE tables are configured as transactional

tables such that they support the ACID property. This is a key feature

introduced in HIVE version 0.14.

N/A Interact when configured with IBM WebSphere Application Server:

You must configure IBM WebSphere JVM to use JDK 1.7. When IBM

WebSphere Application Server 8.5.5.x is configured with JDK 1.7 and

HTTPS communication, you must use IBM JAVA SDK version 7.0.8.10

or higher.

N/A Using multiple SQL statements for raw SQL queries is not currently

supported on big data user datasources. For related information, search

the IBM Knowledge Center for Hive query language conformance.

N/A Dialog behavior: In certain cases, it is necessary to click twice in order

to activate a field or change a field value.

N/A The monitorEnabledForDeliver configuration property in Campaign|

monitoring is not currently used.

N/A Relevant products limitation: When offer management is performed

from Unica Plan, the "relevant products" functionality, which relates

product IDs to offers, is not available.

N/A Blank or incorrect results from derived fields in a Mail List process.

This can occur in a process box that uses a derived field that calls a

Generated field (UCGF) that changes value.

Do not use a UCGF in a Mail List derived field if the UCGF is not

constant. Also, from the Parameters tab, do not create a derived field to

call a UCGF to populate offer attributes.
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N/A Profiling a Campaign Generated Field (UCGF) does not yield correct

results. Some UCGFs have a value according to the cell or the offer

being processed. For cell-related UCGFs, only the value associated with

the first cell appears during profiling.

N/A The default value for a custom cell attribute does not appear when

you open the target cell spreadsheet. Although the default value is not

initially displayed, it will be used. The value can be displayed or changed

by clicking or opening and editing the custom cell attribute in the target

cell spreadsheet.

N/A The UA_UsrResponseType.Name field cannot contain a left parenthesis

followed by a single quote.

N/A Use unique TempTablePrefix for each data source when mapping

multiple data sources to same physical database.

If you mapped multiple data sources in Unica Campaign to the same

physical database, and you use the same TempTablePrefix for more

than one of the data sources, when you use the cleanup utility to delete

orphaned temp tables, it may falsely identify temp tables as orphaned,

when they are in fact legitimate temp tables defined from a different

Unica Campaign data source.

Any deleted temp tables will automatically be recreated when you

rerun affected flowcharts, but as a best practice, use a unique

TempTablePrefix for each data source when mapping multiple data

sources to the same physical database.

If the data sources defined in Unica Campaign map to different

schemas in the database, another solution is to ensure that the

database user who runs the cleanup utility does not have privileges to

drop tables in other schemas in the same database.
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161323 The error "Login failed. Error 10553" can occur if you try to log in to the

Campaign utilities when the Unica Platform | Security | login method

is set to Windows integrated login or Web access control. To avoid

this issue, change the login type to LDAP or Platform prior to using the

Campaign utilities..

176377 DB2 10.5 BLU for user DB: No indexing requirement for temp tables

in Unica Campaign datasource. DB2 10.5 (with BLU feature ON) does

not require indexing in Unica Campaign. Unica Campaign has certain

properties for datasources, such as TempTablePreTruncateRunScript,

TempTablePostExecutionSQL, and PostTempTableCreateRunScript,

where you can provide SQL or scripts to create indexes on user

database tables. If you are using DB2 10.5 as a customer database,

with the BLU feature ON, you do not need to configure any of these

temp table properties.

201,968,200,241 If two process boxes are moved very close together in a flowchart,

the direction of the connection arrow changes. This limitation affects

the visual representation of the arrow. The process data flow is not

affected. The workaround is to move the process boxes farther apart so

the arrowhead changes back to the correct direction.

211293 In  Unica Campaign, the built-in macro Current_Date() results in an error

when executed against a Hive 1.2 based Big Data instance. The Hive

ODBC driver does not support the Current_Date macro to obtain interval

values. For example, executing the following query results in a Hive

error:

SELECT DISTINCT customerid FROM Customer_date WHERE

((Customer_date.my_date_mmdyyyy - CURRENT_DATE()) >= 7)

Error: Hive 2 Internal error: unsupported conversion from type:

interval_day_time
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Workaround: To use the Current_Date function in a RAW SQL query on

Hive with Hortonworks, execute SQL in the following format:

SELECT DISTINCT customerid FROM Customer_date WHERE

(current_date() - my_date_mmddyyyy ) = interval '0 0:0:0' day to second

310769 In Unica Campaign, the built-in macro Current_Date() results in an

error when executed against Impala data source. The Impala ODBC

driver does not support the Current_Date macro to obtain interval

values. For example, executing the following query results in an error:

INSERT INTO TABLE UAC_133824_5 SELECT DISTINCT store_id,

d_customer_key FROM srvacammo.bast_segment WHERE

(srvacammo.bast_segment.ba_last_trans_date > (CURRENT_DATE - 2))

Error: Error while executing a query in Impala: [HY000] :

AnalysisException: Could not resolve column/field reference:

'current_date'

Workaround: In raw SQL query, the Current_Date would not work

with Impala, so instead of current_date, users can use now() or

current_timestamp().

213088 If Campaign is installed in a secured environment but IBM Cognos is in

an unsecured environment, Cognos reports will not display when you

use Microsoft Internet Explorer 11. Workaround: If Unica Campaign is

configured with HTTPS, also configure IBM Cognos on HTTPS.

217488 IBM can support the Database Loader for Redshift until the moment

Campaign triggers the Loader Script. Any problems in execution of the

loader script are not supported by IBM.

223716 Authentication Bypass Using HTTP Verb Tampering

Instead of applying theHttpVerbFilter.class patch, you can use the

following workaround to ensure application security.

Complete the following steps to update web.xml.
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1. Update the web app tag and set the xsd version to 3.0.

<web-app xmlns:xsi="http://www.w3.org/2001/XMLSchema-

instance" 

  xmlns="http://java.sun.com/xml/ns/javaee"

  xsi:schemaLocation="http://java.sun.com/xml/ns/

javaee 

  http://java.sun.com/xml/ns/javaee/web-app_3_0.xsd"

  id="Platform" version="3.0" metadata-

complete="true">

2. Add the following in web.xml.

<!--[start] WhiteList Http Verbs -->

<security-constraint>

  <web-resource-collection>

  <web-resource-name>Unica_WhiteList_Http_Verbs</web-

resource-name>

  <url-pattern>/*</url-pattern>

  <http-method-omission>GET</http-method-omission>

  <http-method-omission>POST</http-method-omission>

  <http-method-omission>TRACE</http-method-omission>

  <http-method-omission>PUT</http-method-omission>

  <http-method-omission>DELETE</http-method-omission>

  <http-method-omission>PATCH</http-method-omission>

  <http-method-omission>OPTIONS</http-method-omission>

  <http-method-omission>HEAD</http-method-omission>

  </web-resource-collection>

  <auth-constraint/>

</security-constraint>

<!--[end] WhiteList Http Verbs -->
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283805 IBM Websphere Application Server 8.5.5 Fix Pack 12 requires IFPI85892

to run HCL Unica application.

283544 On Oracle 12.2 database server following parameters needs to be

added in sqlnet.ora file located under ORACLE_HOME/network/admin/

SQLNET.ALLOWED_LOGON_VERSION_SERVER

User will need to consult with DBA to provide appropriate value to this

parameter. Please refer this link for details: https://docs.oracle.com/

database/121/NETRF/sqlnet.htm#NETRF2016

N/A Campaign Integration with Watson Marketing Assistant is not

supported on Internet Explorer.

286705 Two events get generated on the Campaign history tab when user

pauses the Campaign flowchart from Operational monitoring.

287100 History tab data remains in UA_History table even after deleting the

Campaign

290172 Cutting off right contents from Relevant offers window.

Workaround: The size of text, apps and other items - under Display

should be set to 100%.

312318 Campaign flowchart run - when executed as complete flowchart

generates a unique runID and its executed the flowchart along with

mailchimp process box.

Next time when Campaign user tries to run the single process box - it

does not generate unique runID and thus process box execution failed.

312296 HTTPS(Invalid certificate) HIP instance is not supported in IE11 for Link

PB and Manage Link Connections page.

312320 MailChimp - Audience value is getting changed to other format

f239295fe8 (in alphanumeric format) if we re-open correctly configured

https://docs.oracle.com/database/121/NETRF/sqlnet.htm#NETRF2016
https://docs.oracle.com/database/121/NETRF/sqlnet.htm#NETRF2016


Unica Campaign V12.1 Release Notes | 1 - Release Notes | 36

ID Known limitation

Link PB. The workaround is to hit the Fetch button adjacent to the field

which will refresh the value of the user-friendly string value.

312567 Campaign installer failed to update Insights report files when installed

using non-root user on Unix environment. To overcome this user

would need to update Insights report file manually after installation is

completed.

1. Navigate to <PLATFORM_HOME>/Insights/tools/bin/

2. For UNIX:

• Grant read, write, and execute permissions to -bPath=<Report

folder path> for the installation user.

• Grant execute permission to the installation user using the

following command.

chmod 755 insightsDBUtil.sh

3. Execute command to update the Campaign Insights report files.

./insightsDBUtil.sh -ds=CampaignDS -bPath=<Report folder path> -

DBType=<databasetype> -URL=JDBC connection URL> -user=<database

user> -pwd=<database password>

For more details refer UnicaInsights12_1InstallationConfigurationGuide

313216 Link: Unica application on HTTPS and unica Link on HTTP does not

render the Manage links connections page.
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Known limitations in Unica Optimize V12.1

Issue Number Description

Strings in the production or

test pop-up window are not

translated.

Defect

176920

In the case of a non-English setup, the

strings in the production or test pop-up

window are not translated.

The MailList process fails

with the following database

error: ORA-00999: INVALID

VIEW NAME.

Defect

170951

Change the value of UseTempTablePool

from TRUE to FALSE in UA_SYSTEM_TABLES.

The MailList run will end successfully.

Unica Optimize does not

terminate the unica_acsvr

process that is opened

during a run.

Defect

164875

In case of a schedule run of a Unica

Optimize session by using the Unica

Platform Scheduler, you observe multiple

unica_acsvr login processes. These

processes might terminate automatically

after some time.

A DB2 database user change

of system tables causes a

Unica Optimize session to

fail when the administrator

has an index with the same

name.

Defect

155876

To avoid having a session fail, the DB2

database administrator should remove

indexes.

In a Unica Optimize report,

offers by type and segment

do not get printed as

desired.

Defect

102889

The following issues were noticed while

printing the offers by type and segment in a

Unica Optimize report.

1. The preview window does not scroll,

unless it is resized.
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2. While printing it does not print

everything, but only what fits in A4 size.

Printing options do not seem to make

any difference.

Negative scores cause

inaccurate rules crediting.

DEF041400 If you use negative scores, rule crediting in

the Offer Filtering Summary report might

not be accurate.

Offers with negative scores are given to

meet minimum requirements only.

Cells that are linked to TCS

with offer assignments

do not appear in Optimize

process.

DEF061355 If the Optimize process is connected to

one or more cells and the upstream cells

are later linked to top-down cells defined in

the Target Cell Spreadsheet process (TCS),

the offers that are assigned in the TCS do

not automatically appear in the Optimize

process. Link to any top-down cells in the

TCS before you connect those cells to an

Optimize process. Otherwise, you must

either manually assign the same offers

within the Optimize process, or delete the

Optimize process and re-create it.

Running the ACOOptAdmin

utility with one-way SSL

requires more setup.

DEF046832 You cannot use the ACOOptAdmin utility

with one-way SSL until you register a

security certificate, specify a host name and

domain, and configure SSL_Options in the

ACOOptAdmin.bat file.

Unable to run the session

in first attempt when

DEF055010 If you use the kill command to stop

unica_acosvr, the next time you attempt

to run a Unica Optimize session, it might
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unica_acosvr process

stopped.

fail with the following error: An unknown

communication failure has occurred

with the  Optimize server process.

Workaround - Run the Unica Optimize

session again to complete it successfully.
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